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fonctionnalités de votre nouveau 
lecteur MP3
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP3 est tout 
cela à la fois et plus encore ! Sa technologie de pointe offre une qualité de 
son et d’image exceptionnelle et permet d’accéder à des jeux pleins d’action. 
Vous ne pourrez plus vous passer de votre nouveau lecteur MP3, que ce soit 
pour pratiquer une activité physique, télécharger vos chansons préférées, 
regarder des vidéos, utiliser des jeux ou même écouter la radio.
Utilisez-le ne serait-ce qu’une seule fois et vous vous demanderez comment 
vous avez pu vivre sans !
TOTALEMENT MULTIMEDIA
Nous l’appelons lecteur MP3 mais c’est bien 
plus que ça. Il permet d’affi cher des images, du 
texte, des vidéos d’écouter la radio et même 
de jouer.

LA NAVIGATION TACTILE !
Le pavé tactile vous permet de naviguer dans 
les différents menus très facilement.

ASPECT DE L’ECRAN COULEUR LCD
Des images aux couleurs vives peuvent être 
affi chées sur l’écran LCD.

LA LIBERTE D’ECOUTER VOTRE MUSIQUE 
FAVORITE OU VOUS LE VOULEZ!
Vous pouvez créer des listes de lecture avec 
votre musique préférée.

ECOUTE PROLONGEE ET DUREE DE 
TELECHARGEMENT REDUITE !
Une batterie entièrement chargée permet 
de lire jusqu’à 30 heures de musique ou 4 
heures de vidéo.
La durée de téléchargement a en outre été 
sensiblement réduite. Grâce au standard 
USB 2.0, le lecteur est bien plus rapide que 
les modèles utilisant le format USB 1.1.

UNE QUALITE D’ECOUTE EXCEPTIONNELLE
Votre nouveau lecteur MP3 intègre la 
technologie sonore exclusive DNSe™ (Digital 
Natural Sound engine) de Samsung, fonction 
permettant de fournir un son d’une pureté 
et d’une richesse incroyable pour un plaisir 
d’écoute inégalé.



consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION

Indique un risque potentiel de blessure ou de dégât 
matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de 
décharge électrique ou de blessure lorsque vous utilisez le 
lecteur MP3, respectez les consignes de sécurité suivantes :

REMARQUE
Indique des conseils ou des pages auxquelles se référer 
afi n d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous 
blesser et de blesser d’autres personnes. 
Veuillez respecter scrupuleusement les consignes. 
Après avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit sûr afi n 
de pouvoir vous y référer ultérieurement.



consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau
lecteur MP3. Lisez-le attentivement avant toute utilisation afi n d’éviter
d’endommager votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une 
telle situation se produit malgré tout, n’allumez pas le lecteur car vous 
risqueriez de vous électrocuter. Contactez plutôt le service clientèle de 
Samsung le plus proche de chez vous.

N’utilisez pas ce produit en cas d’orage et de foudre. Vous vous 
exposeriez à un risque de dysfonctionnement ou de décharge électrique.

N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.

Faites particulièrement attention lorsque le câble USB du lecteur n’est 
pas branché et pend dans le vide. 
La fi che USB possède des bords tranchants et risque de vous blesser.

Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie ; vous risqueriez de provoquer un incendie ou une 
décharge électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
L’utilisation prolongée des écouteurs ou du casque peut fortement réduire 
votre acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée 
prolongée, votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus 
votre acuité auditive diminue (le niveau sonore d’une conversation ordinaire est compris 
entre 50 et 60 dB alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
Si vous ressentez des bourdonnements dans les oreilles, réduisez le 
volume ou n’utilisez plus les écouteurs ou le casque.

PROTEGEZ VOTRE LECTEUR MP3
Ne laissez pas l’appareil dans un lieu où la température excède 35°C 
(ex. : sauna ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
Veillez à toujours enregistrer vos données les plus importantes. Samsung 
ne saurait être tenu pour responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou d’en détériorer la surface.
Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de 
paramétrer l’option d’impression « Ajuster à la taille de la page » pour 
qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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fonctions de base
CONTENU
Votre nouveau lecteur MP3 est fourni avec les accessoires présentés 
ci-dessous. Si l’un de ces éléments ne se trouve pas dans l’emballage, 
contactez le service clientèle de Samsung.

Lecteur Ecouteurs

Câble USB CD d’installation

 Il se peut que les accessoires livrés avec votre appareil soient légèrement 
différents de ceux illustrés.
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VOTRE LECTEUR MP3

Trou de la cordelette

Interrupteur Alimentation et 
Verrouillage
Faites glisser vers le bas du lecteur 
pour allumer/éteindre l’appareil.
Faites glisser vers le haut du lecteur 
pour verrouiller les fonctions des 
boutons.

Bouton de réinitialisation
Si un dysfonctionnement du lecteur 
survient, appuyez sur le bouton de 
réinitialisation à l’aide d’un objet 
pointu afi n de réinitialiser le système.

Microphone
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VOTRE LECTEUR MP3 (Suite)
Les boutons suivants sont des touches tactiles.

Bouton de retour en arrière
Appuyez légèrement pour aller à l’écran 

précédent. Appuyez longuement sur ce bouton 
pour accéder à l’écran du menu principal

Bouton d’augmentation du volume
Appuyez légèrement pour augmenter le 
volume ou accéder à l’élément/au menu 

précédent.

Bouton de lecture/pause, sélection
Appuyez légèrement pour sélectionner la lecture/
pause et la fonction et accéder à l’écran suivant.

Bouton d’accès au fi chier précédent
Ce bouton permet de sélectionner la plage/le 

menu précédent(e) ou de lire la plage en 
cours à partir du début. Appuyez longuement 
sur ce bouton pour passer rapidement d’une 

plage à une autre..

Bouton de réduction du volume
Ce bouton permet de diminuer le volume ou 

d’accéder à l’élément/au menu suivant.

Bouton d’accès au fi chier suivant
Ce bouton vous permet d’accéder à la plage/au 

menu suivant(e). Appuyez longuement sur ce 
bouton pour passer rapidement d’une plage à une 

autre.

Bouton de menu
Appuyez légèrement pour affi cher l'écran de 

menu.



fonctions de base _ 13

VOTRE LECTEUR MP3 (Suite)

Ecouteurs
Pour votre confort, les lettres L 

(écouteur gauche) et R (écouteur 
droit) sont gravées sur chaque 

écouteur. Ce cordon sert également 
d’antenne radio.

Si vous débranchez les écouteurs 
pendant la lecture des données 

musicales, la lecture s’interrompt.

Prise pour écouteurs

Port USB

Trou de la cordelette
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Music
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ECRANS
Musique

1 Témoin du menu associé

2 Témoin verrouillage

3 Etat de la batterie

4
Témoin de lecture de la plage en 
cours/du nombre total de plages

5 Témoin de vitesse de lecture

6 Heure actuelle

7 Durée de lecture totale

8
Témoin Lecture / Pause / 
Recherche

9 Témoin du mode Musique

10 Témoin du mode Lecture

11 Témoin du mode DNSe

12 Ecran Lect mus.

13 Titre de la plage

14 Barre d’état de la lecture

15 Durée de lecture actuelle

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.
Les informations non liées à l’écran de lecture musicale s’affi chent très brièvement. 
Pour les visualiser à nouveau, appuyez légèrement sur n’importe quel bouton.

REMARQUE
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ECRANS (Suite)
Vidéo

1 Témoin verrouillage

2 Etat de la batterie

3 Heure actuelle

4 Durée de lecture totale

5 Témoin Lecture / Pause / 
Recherche

6 Témoin du mode Vidéo

7 Nom du fi chier

8 Barre d'état de la lecture

9 Durée de lecture actuelle
Image

1 Témoin verrouillage

2 Etat de la batterie

3 Témoin du fi chier en cours/
du nombre total de fi chiers

4 Heure actuelle

5 Etat de la lecture des 
fi chiers musicaux

6 Témoin du mode Image

7 Témoin du menu associé

8 Nom du fi chier
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[Ecran de prévisualisation]
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ECRANS (Suite)
Radio FM

1 Heure actuelle

2 Etat de la batterie

3 Témoin verrouillage

4 Témoin du mode Radio

5 Témoin Manuel / Présélectionné

6
Témoin de la fréquence en cours 
(MHz)

7
Témoin de la barre de fréquence 
radio

8 Témoin RDS

Qu’est-ce que le RDS ?
La fonction Système de Radiocommunication de Données (RDS) permet la 
réception et l’affi chage de messages comme la diffusion d’informations. Les 
informations relatives aux programmes (ex. : actualités, sport ou musique) ou aux 
stations de radiodiffusion s’affi chent sur cet écran.
Si la puissance du signal FM est faible, les informations RDS ne s’affi chent pas.

1

Manual

3

4

6

7

2

5

News
 Today Headline

8

REMARQUE
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UTILISATION DES BOUTONS TACTILES
Appuyez légèrement sur le bouton tactile du bout du doigt.

Afi n de ne pas endommager le bouton tactile, utilisez uniquement vos doigts pour 
l’activer.
Veillez toujours à avoir les mains propres avant d’utiliser votre appareil.
N’utilisez jamais le bouton tactile les mains gantées.
Il est possible que le bouton ne fonctionne pas si vous utilisez votre ongle ou un 
autre objet tel qu’un stylo à bille.

REMARQUE
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CHARGEMENT DE LA BATTERIE
Chargez-la avant d’utiliser votre lecteur pour la première fois ou lorsque vous 
ne l’avez pas utilisé pendant une période prolongée.
La batterie de votre lecteur MP3 se charge complètement en environ trois 
heures, mais cette durée peut varier en fonction de la confi guration de votre 
ordinateur.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion 
USB situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.

2

Affi chage à l’écran
USB connected 
(USB connecté)

< > - Chargement

< > - Chargement
terminé

1
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez les consignes d’entretien et 
de rangement du lecteur.
• Rechargez la batterie dans un lieu où la température est comprise entre 5 et 35 °C.
• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie.
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.
Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie 
du portable est entièrement chargée ou que l’ordinateur est lui-même relié à une 
prise secteur.
La batterie rechargeable intégrée à ce produit ne peut pas être remplacée par 
l’utilisateur. Pour plus d’informations sur son remplacement, contactez votre 
fournisseur de services.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Faites glisser l’interrupteur [ ] vers le bas du 
lecteur.

L’appareil s’allume.

Mise hors tension de l’appareil
Faites à nouveau glisser l’interrupteur [ ] vers le 
bas du lecteur.

L’appareil s’éteint.
L’appareil s’éteint automatiquement lorsque aucun des boutons n’est actionné 
pendant une durée prédéfi nie en mode Pause (Pause). La durée par défaut de 
<Auto Power Off> (Extinction auto) est de 1 minute, mais vous pouvez la modifi er. 
Consultez la page 29 pour plus d’informations.

REMARQUE

REMARQUE

ATTENTION
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LECTURE DE MUSIQUE
Téléchargez des fi chiers musicaux sur votre nouveau lecteur MP3 à l’aide de 
EmoDio.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Music> (Musique), puis sur le 
bouton [Sélection].

3. Servez-vous du bouton [Haut, Bas] et du bouton
[Sélection] pour sélectionner le fi chier musical de votre 
choix.

4. Appuyez légèrement sur le bouton [Sélection] pour lire le fi chier musical 
sélectionné.

La lecture du fi chier musical démarre.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

CONTROLE DU VOLUME
Appuyez légèrement sur le bouton [Haut, Bas].

L’icône du contrôle de volume s’affi che.
La plage de réglage du volume est comprise entre 0 et 30.
Appuyez légèrement sur le bouton [Haut] pour augmenter le 
volume et sur le bouton [Bas] pour le diminuer.

Music

Rising Sun

02:13 04:28

Music

Rising Sun

02:13 04:28

REMARQUE
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VERROUILLAGE DES BOUTONS
La fonction Verrouillage permet de verrouiller tous les boutons du lecteur MP3 ;
ainsi, si vous appuyez sur une touche par mégarde lors de la lecture d’un 
fi chier, celle-ci ne sera pas interrompue.
1. Faites glisser l’interrupteur [ ] vers le haut du 

lecteur pour activer la fonction de verrouillage.
2. Faites glisser l’interrupteur [ ] vers le bas du 

lecteur pour désactiver la fonction de verrouillage.

RECHERCHE DE FICHIERS A L’AIDE DU 
« DOSSIER NAVIGATEUR »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser> 
(Dossier Navigateur).
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <File Browser> (Dossier 
Navigateur), puis sur le bouton [Sélection].

Le dossier <File Browser> (Dossier Navigateur) contenant 
des fi chiers musicaux, des listes de lecture, des vidéos, des 
images, des listes de diffusion, des textes, des jeux, des fi chiers 
enregistrés et Mon pack apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le dossier 
souhaité.

4. Appuyez légèrement sur le bouton [Sélection] pour affi cher la liste des 
fi chiers dans le dossier sélectionné.

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier souhaité.
6. Appuyez légèrement sur le bouton [Sélection].

La lecture du fi chier démarre.

Music

Rising Sun

02:13 04:28
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SUPRESSION DE FICHIERS A L'AIDE DU « DOSSIER 
NAVIGATEUR »
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <File Browser> (Dossier 
Navigateur), puis sur le bouton [Sélection].

Le contenu de la liste des dossiers <File Browser> (Dossier 
Navigateur) apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le dossier souhaité, puis sur le bouton
[Sélection].

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier 
que vous souhaitez supprimer, puis sur [ ].

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner <Delete>
(Supprimer), puis sur le bouton [Sélection].

Une fenêtre de confi rmation apparaît.

6.  Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner 
<Yes> (Oui), puis sur le bouton [Sélection].

Le fi chier sélectionné est supprimé.

Une fois supprimés, les fi chiers ne peuvent plus être récupérés.

Le fi chier en cours de lecture ne peut pas être supprimé.

<My Pack> (Mon pack) sous <File Browser> (Dossier Navigateur) est le dossier 
dans lequel sont stockés les fi chiers DNSe transférés via <EmoDio>. Pour obtenir 
plus d’informations sur DNSe, reportez-vous à <EmoDio>.

REMARQUE

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
My Pack

ATTENTION
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MODIFICATION DES REGLAGES ET DES PREFERENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

Réglages du style du menu
Vous pouvez modifi er l’aspect et la police du menu et supprimer l’image 
de fond d’écran du menu principal.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas]

pour sélectionner <Menu Style> (Style du menu), 
puis sur le bouton [Sélection].

Le menu <Menu Style> (Style du menu) s’affi che.
4. Les boutons [Haut, Bas] et [Sélection] servent à régler les fonctions.

Appuyez légèrement sur le bouton [Sélection] pour passer à l’élément 
suivant ou sélectionner le menu.
Appuyez légèrement sur le bouton [Haut, Bas] pour monter ou descendre 
dans le menu actuel. 

Options de réglage du style du menu 
Menu Design (Aspect du menu) : Vous pouvez modifi er le style de l’écran du 
menu principal. Choisissez entre <Matrix> (Matrice) et <My Skin> (Mon habillage).
Font (Police) : Vous pouvez modifi er le type de police du menu. 3 types de police 
sont proposés. Il est possible que pour certaines langues de menu, l’option <Font> 
(Police) soit désactivée.
Reset My Skin (Réinitialiser mon habillage) : Permet d’initialiser l’image de fond de 
l’écran tactile par l’image par défaut.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du 
volume sonore.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Sound> (Son), puis sur le bouton 
[Sélection].

Le menu <Sound> (Son) s’affi che.

4. Les boutons [Haut, Bas] et [Sélection] servent à régler les fonctions.

Options de réglage du son
Master EQ (EG princ.) : Vous pouvez optimiser les réglages du son. Appuyez 
légèrement sur le bouton [Gauche, Droite] pour sélectionner la fréquence que 
vous souhaitez paramétrer. Appuyez légèrement sur le bouton [Haut, Bas] pour 
régler le niveau de la fréquence sélectionnée, puis sur le bouton [Sélection].
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission d’un 
signal sonore lors des opérations effectuées sur l'écran tactile. Choisissez entre 
<Off> (Arrêt) et <On> (Marche). 
Volume Limit (Limitation du Volume) : Vous pouvez éviter l’apparition de troubles 
auditifs en réglant l’intensité du volume sonore lors de l’utilisation des écouteurs. 
l’option <On> (Marche) fi xe le niveau maximal du volume à 15. Le niveau 
maximal du volume lorsque la limite est réglée sur <Off> (Arrêt) est de 30. Même 
si vous avez sélectionné <Off> (Arrêt), le volume reviendra au niveau 15 lorsque 
vous rallumerez le lecteur afi n de vous éviter toute lésion du système auditif.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglage de l’affi chage
Modifi ez l’heure d’arrêt de l’affi chage et la luminosité de votre écran.

1. Appuyez longuement sur [ ] pour accéder à 
l’écran du menu principal.

2. Appuyez légèrement sur le bouton [Haut, Bas, 
Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Display> (Affi cher), puis sur le 
bouton [Sélection].

Le menu <Display> (Affi cher) s’affi che.

4. Les boutons [Haut, Bas] et [Sélection] servent à régler les fonctions.

Options de réglage de l’affi chage
Display Off (Affi ch. Désactivé) : Si aucun nombre n’est entré pour la sélection 
de la période, l’écran s’éteint automatiquement. Vous pouvez choisir entre 
<15sec>, <30sec>, <1min>, <3min>, <5min>, et <Always On> (Toujours 
allumé). Pour rallumer l’écran, il vous suffi t d’appuyer sur n’importe quel bouton.
Brightness (Luminosité) : Permet de régler la luminosité de l’écran d’affi chage. 
Sélectionnez un niveau <0-10>, où 10 est le plus lumineux.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP3. Vous pouvez changer facilement de 
préférence de langue.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Language> (Langue), puis sur le 
bouton [Sélection].

La liste <Language> (Langue) s’affi che.
<English>, < >, <Français>, <Deutsch>, <Italiano>, < >,< >,
< >, <Español>, < >, <Magyar>, <Nederlands>, <Polski>, 
<Português>, <Svenska>, < >, < eština>, < >, <Türkçe>, <Norsk>, 
<Dansk>, <Suomi>, <Español (Sudamérica)>, <Português (Brasil)>, <Indonesia>, 
<Ti ng Vi t>, <Bulgarian>, <Român >, < >, <Slovenš ina> et 
<Slovenský>.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la 
langue de votre choix, puis sur le bouton [Sélection].

Les langues prises en charge peuvent être modifi ées ou ajoutées.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de la date et l’heure
Réglez la date et l’heure actuelle.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Date&Time> (Date et heure), 
puis sur le bouton [Sélection].

L’écran Time Set (Réglage heure) s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour accéder 
respectivement à <YEAR, MONTH, DATE, HOUR, MIN, AM/PM>
(Année, Mois, Jour, Heure, Minute, AM/PM) puis appuyez légèrement 
sur le bouton [Haut, Bas] pour régler chaque élément séparément.

5. Appuyez légèrement sur le bouton [Sélection].
La fenêtre de confi rmation d’enregistrement apparaît.

6. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis sur le bouton [Sélection].

L’heure et la date sont enregistrées.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du système
Sélectionnez le mode Veille, Début, Extinction auto ou Réglage par 
défaut adapté.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Settings>
(Paramètres), puis sur le bouton [Sélection].

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <System> (Système), puis sur le 
bouton [Sélection].

Le menu <System> (Système) s’affi che.

4. Les boutons [Haut, Bas] et [Sélection] servent à régler les fonctions.

Settings

Menu Style
Sound
Display
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Date&Time 
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage du système

My Profi le (Mon profi l) : Vous permet de saisir votre nom et votre date de naissance. 
Reportez-vous aux pages 30~31.
Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après l’écoulement de 
la durée préréglée. Options disponibles : <Off> (Arrêt), <15min>, <30min>, <60min>, 
<90min> ou <120min>.
Start Mode (Mode Début) : Permet de défi nir l’écran de démarrage affi ché lors de la mise 
sous tension du lecteur. Choisissez entre <Main Menu> (Menu Principal) et <Last State> 
(Dernier Etat). Sélectionnez <Main Menu> (Menu Principal) pour démarrer le système avec 
l’écran du menu principal et <Last State> (Dernier Etat) pour affi cher l’écran du dernier 
menu utilisé.
Auto Power Off (Extinction auto) : Permet d’éteindre automatiquement l’appareil 
lorsque celui-ci est en mode Pause et qu’aucun bouton n’est actionné avant l’écoulement 
de la durée prédéfi nie. Choisissez entre <15sec>, <30sec>, <1min>, <3min>, <5min> et 
<Always On> (Toujours allumé).
Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage par défaut. 
Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) vous permet de réinitialiser 
l’appareil sur les réglages par défaut. <No> (Non) permet d’annuler les réglages par défaut.
Format (Formater) : Vous permet de formater la mémoire interne. Options disponibles 
: <Yes> (Oui) ou <No> (Non). Le réglage sur <Yes> (Oui) formate la mémoire interne et 
supprime tous les fi chiers du lecteur. En revanche, <No> (Non) ne lance pas le formatage 
de la mémoire interne. vérifi ez avant de lancer le formatage.
About (A propos de) : Appuyez légèrement sur le bouton [Gauche, Droite] pour consulter 
les informations relatives à la version du micrologiciel, à la capacité de la mémoire et au 
numéro de fi chier.
<Firmware Version> (Version du fi rmware) affi che la version actuelle du micrologiciel.
<Used> (Utilisé) indique la capacité de mémoire actuellement utilisée, <Available> 
(Disponible) la capacité restante de la mémoire et <Total> la capacité totale de la mémoire. 
<Files> (Fichiers) permet de consulter le nombre de fi chiers musicaux, de vidéos, 
d’images, de textes ainsi que le nombre total de fi chiers.
Demo Mode (Mode Démo) : Si vous le réglez sur <On> (Marche), le lecteur répète la 
lecture du clip stocké sur le dossier vidéo. Appuyez légèrement sur le bouton tactile pour 
revenir à l’écran précédent.

A propos de la mémoire intégrée
1 Go=1,000,000,000 octets : la capacité réelle formatée peut être inférieure, 
car le micrologiciel interne en utilise une partie.

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglage du nom

1. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <My Profi le> (Mon profi l) puis sur 
le bouton [Sélection].

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <My Name> (Mon nom) puis sur 
le bouton [Sélection].

La fenêtre Rename My Name (Renom. Mon nom) 
apparaît.

3. Utilisez les boutons [Haut, Bas, Gauche, Droite] et [Sélection] pour 
renommer l’appareil.

[  ] : Le mode de saisie passe de Lettres majuscules à Lettres 
minuscules et Chiffre.

[  ] : Vous permet de supprimer les caractères l’un après l’autre.
[  ] : Vous permet d’insérer « – ».
[  ] : Vous permet de confi rmer votre modifi cation.
Lorsque le réglage de nom est terminé, votre nom s’affi che lorsque vous 
allumez le lecteur.

Rename My ..

_
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglage Mon anniversaire

Avant de démarrer - Vous devez tout d’abord régler l’horloge.
Reportez-vous à la page 27.

1. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <My Profi le> (Mon profi l) puis sur 
le bouton [Sélection].

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <My Birthday> (Mon 
anniversaire) puis sur le bouton [Sélection].

La fenêtre Edit My Birthday (Editer Mon anniversaire) 
apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] pour accéder 
respectivement à <YEAR, MONTH, DATE> (Année, Mois, Date) et 
appuyez légèrement sur le bouton [Haut, Bas] pour régler chaque 
élément séparément.

4. Appuyez légèrement sur le bouton [Sélection].
Lorsque le réglage de la date de naissance est terminé, votre anniversaire 
vous est rappelé lors de la mise sous tension du lecteur.

Edit My Birth..
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REINITIALISATION DU SYSTEME
Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fi chier ou n’est 
pas reconnu par votre ordinateur lorsque vous le branchez, il est préférable de 
réinitialiser le système.

Veillez à ne pas appuyer sur l’orifi ce du microphone à l’aide d’un objet pointu pour 
ne pas endommager le produit. ATTENTION

Appuyez sur le bouton de réinitialisation 
situé sur la partie inférieure de l'appareil à 
l'aide d'un objet pointu, comme une agrafe.

Le système est réinitialisé.
La fonction Reset (Réinitialisation) ne permet 
pas de supprimer les renseignements de durée 
et les données enregistrées dans la mémoire 
intégrée.
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EmoDio
EmoDio est une application logicielle fournie avec ce lecteur MP3 qui 
est destinée à la prise en charge de divers services aux contenus et 
de différents supports de périphérique.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme à la confi guration minimale requise suivante 
pour que vous puissiez installer et exécuter EmoDio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou 

ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque 

dur

• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10 ou 

ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou version 

ultérieure
• Mémoire vive 512 Mo ou plus

Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n 
d’éviter une mauvaise connexion.

Toutes les fonctions sont désactivées durant le branchement.
Utilisez le système de fi chiers FAT 32 pour le formatage du lecteur sur votre 
ordinateur.Sous Windows Vista, cliquez sur « Restore device defaults » (Restaurer 
les paramètres par défaut du périphérique) et formatez-le.

ATTENTION

REMARQUE
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INSTALLATION D’EMODIO
Assurez-vous que le programme d’installation <EmoDio>> a été lancé à partir 
du compte administrateur de votre ordinateur. Dans le cas contraire, <EmoDio> 
ne pourra pas être installé. Pour trouver le compte administrateur, veuillez vous 
reporter au manuel d’utilisation de votre 
ordinateur.

1. Insérez le CD d’installation fourni avec 
l’appareil dans le lecteur de CD-ROM 
de votre ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

Suivez les instructions pour démarrer l’installation.
L’installation de <EmoDio> démarre et une icône  s’affi che sur votre Bureau 
lorsque celle-ci est terminée.

N’effectuez pas de mouvements brusques lorsque vous utilisez un CD-ROM installé 
à la verticale pour le chargement/le retrait du CD d’installation.

La technologie de reconnaissance musicale et les données relatives sont fournies 
par Gracenote et Gracenote CDDB®  Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote.

ATTENTION

ATTENTION

REMARQUE
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UTILISATION D’EMODIO
L’application logicielle EmoDio est facile à utiliser et vous permet de classer 
vos fi chiers sur votre ordinateur. Une fois vos fi chiers classés et organisés dans 
EmoDio, vous pouvez les transférer rapidement vers votre lecteur MP3 sans 
avoir à faire des recherches sur l’ensemble de votre disque dur pour retrouver 
le bon fi chier.

Le programme <EmoDio> est le moyen le plus simple de transmettre 
des fi chiers de votre ordinateur vers votre lecteur MP3.

Grâce à <EmoDio>, vous créez votre propre collection ou liste de 
lecture ainsi que vos fi chiers audio originaux.

Vous pouvez transférer vers le lecteur les informations relatives au 
blog et les fi chiers enregistrés au format RSS.

Il s’agit d’un service communautaire en ligne à l’intention des 
utilisateurs d’EmoDio.com. Il offre une méthode simple et facile de 
charger et télécharger des contenus produits à l’aide d’EmoDio et 
des moyens permettant d’échanger vos expériences avec d’autres 
utilisateurs de la communauté.

Pour plus d’informations sur <EmoDio>, cliquez sur <MENU> <Help> (Aide) 
<Help> (Aide) en haut du programme <EmoDio>.REMARQUE
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lecture de fi chiers musicaux
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

LECTURE PAR CATEGORIE

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite] pour 

sélectionner <Music> (Musique), puis sur le bouton [Sélection].
La liste <Music> <Musique> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la liste 
souhaitée, puis sur le bouton [Sélection].

Le fi chier musical s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier à 
lire, puis sur le bouton [Sélection].

La lecture du fi chier musical démarre.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music

Rising Sun

02:13 04:28

REMARQUE



lecture de fi chiers musicaux _ 37

LECTURE PAR CATEGORIE (Suite)
Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de la 
plage et le genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du fi chier 
musical correspondant. Un fi chier sans étiquette ID3 s’affi che comme [Unknown] (inconnu).
Now Playing (En lecture) : Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de 
lecture du fi chier en cours.
Artists (Artiste) : Lecture par artiste
Albums : Lecture par album. Appuyez légèrement sur [ ] pour sélectionner <List Type> 
(Type de liste). Sélectionnez <Album Art> (Image CD) pour affi cher simultanément la 
jaquette du CD et le titre de l’album ou <List> (Liste) pour visionner uniquement le titre de 
l’album.
Songs (Chansons)  : Lecture en ordre numérique ou alphabétique          
Genres : Lecture par genre
Playlists (Listes de lecture) : Lecture par liste
Recorded Files (Fichiers Enregistrés) : Affi che tous les fi chiers enregistrés.
Music Browser (Navig. musique) : Permet d’affi cher tous les fi chiers musicaux enregistrés 
dans le dossier musical.

Les fi chiers musicaux MP3 et WMA sont compatibles avec ce lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Si vous débranchez les écouteurs pendant la lecture des données musicales, la 
lecture s'interrompt.
Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au 
fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE
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PAUSE
1. Appuyez légèrement sur le bouton [Sélection] lorsque la lecture de la 

musique est en cours.
La lecture de la musique est interrompue.

2. Appuyez légèrement à nouveau sur le bouton [Sélection].
La lecture reprend à l’endroit où vous l’avez suspendue.

RECHERCHE A L’INTERIEUR D’UNE PLAGE
1. Appuyez longuement sur le bouton [Gauche, Droite] pendant que la plage 

sélectionnée est en cours de lecture.
Ces boutons permettent d’effectuer la recherche vers le début ou la fi n de la plage.

2. Relâchez le bouton dès que vous souhaitez reprendre la lecture.
La lecture commence dès que vous relâchez le bouton.

LECTURE DE LA PLAGE EN COURS A PARTIR DU DEBUT
Appuyez légèrement sur le bouton [Gauche] après 3 secondes de lecture.

La plage en cours est lue à partir du début.

LECTURE DE LA PLAGE PRECEDENTE
Appuyez légèrement sur le bouton [Gauche] dans les 3 premières secondes de 
lecture.
Appuyez deux fois sur le bouton [Gauche] après 3 secondes de lecture.

La lecture de la plage précédente démarre.
Pendant la lecture de fi chiers VBR (débit binaire variable), la plage précédente 
peut ne pas être lue même si vous appuyez sur le bouton [Gauche] au cours des 3 
premières secondes de lecture.

LECTURE DE LA PLAGE SUIVANTE
Appuyez légèrement sur le bouton [Droite].

La lecture de la plage suivante démarre.

ATTENTION
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pourrez 
créer une liste de lecture de « Favoris ».
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <File Browser> (Dossier 
Navigateur), puis sur le bouton [Sélection].

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Music> (Musique), puis sur le bouton
[Sélection].

Le(s) fi chier(s) musical/musicaux s’affi che(nt).

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner un fi chier à 
ajouter à la liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner <Add to 
Playlist> (Aj. à liste lect.), puis sur le bouton [Sélection].

<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

6. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner un numéro 
de liste de lecture pour ajouter le fi chier sélectionné, puis sur le bouton
[Sélection].

Le fi chier sélectionné est ajouté à la liste de lecture.
Vérifi ez la liste de lecture dans <Music> (Musique)  <Playlists> (Listes de lecture) 
<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) dans le menu principal.

Vous pouvez ajouter jusqu'à 100 fi chiers musicaux dans chaque liste de lecture 
(<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5)).
Pour obtenir les informations sur la création d’une liste de lecture dans <EmoDio> 
et son transfert vers votre lecteur, reportez-vous à <EmoDio>.

Music

Rising Sun
My love

Add to Playlist
Delete

1/2

REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Music> (Musique), puis sur le 
bouton [Sélection].

La liste <Music> <Musique> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Playlists> (Playlist), puis sur le bouton
[Sélection].

La/Les liste(s) de lecture s'affi che(nt).

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la liste de 
lecture de votre choix, puis sur le bouton [Sélection].

Les fi chiers musicaux enregistrés dans la liste de lecture sélectionnée apparaissent.
Si vous ne trouvez aucune liste de lecture, le message 
<No fi le.> (Aucun fi chier.) s’affi che à l’écran.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier 
musical à lire, puis sur le bouton [Sélection].

La lecture du fi chier musical démarre.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser
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SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 

principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite]

pour sélectionner <Music> (Musique), puis sur le bouton
[Sélection].

La liste <Music> <Musique> s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 

<Playlists> (Playlist), puis sur le bouton [Sélection].
La/Les liste(s) de lecture s'affi che(nt).

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
la liste de lecture de votre choix, puis sur le bouton [Sélection].

Les fi chiers musicaux enregistrés dans la liste de lecture sélectionnée 
apparaissent.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
un fi chier à supprimer de la liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.
6. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 

<Delete from Playlist> (Suppr. de liste lect.), puis sur le bouton
[Sélection].

Le fi chier sélectionné est supprimé de la liste de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 4 ci-dessus.
5. Appuyez légèrement sur [ ].

Le menu de la liste de lecture apparaît.
6. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Delete All from Playlist> (Suppr. tt de liste lect.), 
puis sur le bouton [Sélection].

Tous les fi chiers sont supprimés de la liste de lecture.
Le fi chier sélectionné dans la liste de lecture ne peut pas être 
supprimé en cours de lecture.

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playlist

Playlists

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playli..

REMARQUE
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UTILISATION DU MENU MUSIQUE
Le menu Musique vous permet de gérer toutes les facettes de l’écoute (de la 
sélection des plages et des playlists au choix du fond d’écran durant l'écoute).

Régler l’effet sonore
Profi tez d’une qualité de son plus nette.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Sound Effect> (Effets 
Sonores), puis sur le bouton [Sélection].

Le menu <Sound Effect> (Effets Sonores) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner l’effet sonore souhaité, puis sur le bouton
[Sélection].

Choisissez entre <Street Mode> (Mode Rue) et <Audio Upscaler> (Mise à 
l’échelle audio).

Options d’effet sonore
Street Mode (Mode Rue) : Permet d’écouter clairement en extérieur grâce au 
fi ltrage de certains bruits de la rue. Sélectionnez une valeur de 0 à 2.
Audio Upscaler (Mise à l’échelle audio) : Cette fonction restitue presque 
à l’original les sons sources perdus par encodage WMA/MP3. L’option Audio 
Upscaler (Mise à l’échelle audio) fonctionne uniquement sur des fi chiers 
musicaux de piètre qualité. Sélectionnez <Off> (Arrêt) ou <On> (Marche).

Pour quitter le menu, appuyez légèrement sur [ ].

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à chaque 
genre musical.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <DNSe>, puis sur le bouton
[Sélection].

Le menu <DNSe> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner le DNSe de votre choix, puis sur le bouton
[Sélection].

Choisissez entre <Auto>, <Normal>, <Studio>, <Rock>, <Classical> 
(Classique), <Jazz>, <Ballad> (Ballade), <Club>, <Rhythm & Blues> (R&B), 
<Dance> (Danse), <Café>, <Concert>, <Church> (Église ) et <myDNSe>.
L’option <Auto> sélectionne automatiquement le mode DNSe correspondant 
lorsque les informations relatives au genre musical sont indiquées sur 
l’étiquette ID3 du fi chier musical.
La sélection de l’élément <myDNSe> permet de confi gurer l’option DNSe 
utilisateur. Reportez-vous à la page 44.

Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation sonore conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de musique 
que vous écoutez.

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner MonDNSe
Vous pouvez paramétrer un DNSE Utilisateur sur votre lecteur ou le 
transférer à partir d’<EmoDio>.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <DNSe>, puis sur le bouton 
[Sélection].

Le menu <DNSe> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <myDNSe>, puis sur le bouton [Sélection].

La liste des DNSe utilisateur s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le 
DNSe utilisateur de votre choix, puis sur le bouton [Sélection].

L’élément User DNSe (DNSe utilisateur) sélectionné est ainsi défi ni.
Vous pouvez régler <EQ> (EG), <3D & Bass>, <Concert Hall> (Salle 
Concert) et <Clarity> (Netteté) lorsque l’élément <myDNSe> a été 
sélectionné. Reportez-vous aux pages 45~48.

Pour les détails sur le réglage de l’option User DNSe (User DNSe) à l’aide 
de <EmoDio>, reportez-vous à <EmoDio>.
Il est possible de transférer vers le lecteur un total de 97 valeurs User 
DNSe (DNSe utilisateur) à l’exception des valeurs comprises entre 
<User 1> (Utilisateur 1) et <User 3> (Utilisateur 3).

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On

Rhythm & Blues
Dance
Café
Concert
Church
myDNSe

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner MonDNSe (Suite)
<EQ> (EG)
Vous pouvez paramétrer les fréquences sonores individuellement selon vos 
préférences.

1. Appuyez légèrement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe 
utilisateur de votre choix, puis sur [ ].

La liste des DNSe utilisateur s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <EQ> (EG), puis sur le bouton
[Sélection].

L’écran de réglage <EQ> (EG) apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner la fréquence que vous souhaitez régler, puis sur 
le bouton [Haut, Bas] afi n d’ajuster le niveau de la fréquence 
sélectionnée.

Vous pouvez régler le niveau de la fréquence sélectionnée de <–10 ~ +10> 
<–10 à +10>.

4. Appuyez légèrement sur le bouton [Sélection].
Le réglage est terminé.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity



46 _ lecture de fi chiers musicaux

UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner MonDNSe (Suite)
<3D & BASS>
Vous pouvez régler le son ambiophonique 3D et le niveau d’amplifi cation des 
basses fréquences.

1. Appuyez légèrement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe 
utilisateur de votre choix, puis sur [ ].

La liste des DNSe utilisateur s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <3D & Bass>, puis sur le 
bouton [Sélection].

L’écran de réglage <3D & BASS> apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <3D> (3D) ou <BASS>, puis sur le bouton [Haut, Bas].

Vous pouvez sélectionner <0-4> pour les fonctions <3D> et <Bass>.

4. Appuyez légèrement sur le bouton [Sélection].
Le réglage est terminé.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner MonDNSe (Suite)

<Concert Hall> (Salle de concert)
Vous pouvez régler la taille et le niveau sonore de la salle de concert 
comme si vous écoutiez de la musique dans une véritable salle de 
concert.
1. Appuyez légèrement sur le bouton [Haut, Bas]

dans le menu myDNSe pour sélectionner le DNSe 
utilisateur de votre choix, puis sur [ ].

La liste des DNSe utilisateur s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Concert Hall> (Salle de 
concert), puis sur le bouton [Sélection].

L’écran de réglage <Concert Hall>(Salle de concert) 
apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Size> (Taille) ou <Level> (Niveau), puis sur le bouton 
[Haut, Bas].

Vous pouvez sélectionner une valeur comprise entre <0-3> pour les options 
<Size> (Taille) et <Level> (Niveau).

4. Appuyez légèrement sur le bouton [Sélection].
Le réglage est terminé.

Selon le fi chier musical, la sélection de <Concert Hall> (Salle de concert) 
peut désactiver d’autres effets sonores.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity

REMARQUE



48 _ lecture de fi chiers musicaux

UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner MonDNSe (Suite)

<Clarity> (Netteté)
 Vous bénéfi ciez d’un son plus clair et de meilleure qualité. 
1. Appuyez légèrement sur le bouton [Haut, Bas]

dans le menu myDNSe pour sélectionner le DNSe 
utilisateur de votre choix, puis sur [ ].

La liste des DNSe utilisateur s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Clarity> (Netteté), puis sur le 
bouton [Sélection].

L’écran de réglage <Clarity> (Netteté) apparaît.
Vous pouvez sélectionner une valeur comprise entre <0-2>.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le 
niveau souhaité, puis sur le bouton [Sélection].

Le réglage est terminé.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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UTILISATION DU MENU MUSIQUE (Suite)
Régler le mode de lecture
Permet de sélectionner le mode de lecture tel que les paramètres de 
répétition.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Play Mode> (Mode lecture), 
puis sur le bouton [Sélection].

Le menu <Play Mode> (Mode lecture) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner le mode lecture souhaité, puis sur le bouton
[Sélection].

Options du mode de lecture
Normal : Permet de lire une fois tous les fi chiers de la liste musicale actuelle 

dans l’ordre.
Repeat (Répéter) : Permet de répéter la lecture de tous les fi chiers de la liste 

musicale actuelle.
Repeat One (Répéter 1X) : Permet de répéter la lecture d’un fi chier.
Shuffl e (Aléatoire) : Permet de répéter la lecture de tous les fi chiers de la liste 

musicale actuelle de manière aléatoire.

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On
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Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On

UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner l’écran de lecture musicale
Sélectionnez une image de fond d’écran parmi celles fournies ou 
sélectionnez l’une de vos propres images à affi cher lorsque vous écoutez 
de la musique.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Music Play Screen> (Ecran 
Lect mus.), puis sur le bouton [Sélection].

Le menu <Music Play Screen> (Ecran Lect mus.) s’affi che.
3. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner l’écran de lecture 
musicale de votre choix, puis sur le bouton [Sélection].

Options de l’écran de lecture musicale
Faites votre choix parmi les options suivantes : <Refl ection> (Réfl exion), <Auto> 
(Auto), <Passionate> (Passion), <Sweet> (Doux), <Quiet> (Calme), <Cheerful> 
(Joie), <Album Art> (Image CD) et <Album Info> (Info.album).
Auto : Change automatiquement les écrans de lecture musicale en fonction des 
informations contenues sur l’étiquette ID3 du fi chier musical.
Album Art (Image CD) : L’image de la jaquette du CD s'affi che si une image de 
jaquette fi gure dans les informations de l’étiquette ID3 du fi chier musical. Les 
images de la jaquette du CD d’une taille inférieure à 200 pixels (horizontal) x 200 
pixels (vertical) sont prises en charge.
Album Info. (Info.album) : Les informations concernant le nom de l’artiste, l’album 
et le genre s’affi chent si celles de l’étiquette ID3 sont enregistrées dans le fi chier 
musical.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un 
champ commentaire.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la vitesse de lecture
Accélérez ou ralentissez votre musique préférée en réglant la vitesse de lecture.

1. Appuyez légèrement sur [ ] tout en écoutant de la 
musique.

Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Play Speed> (Vitesse de 
lecture), puis sur le bouton [Sélection].

Le menu <Play Speed> (Vitesse de lecture) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner la vitesse de lecture souhaitée, puis sur le bouton
[Sélection].

Faites votre choix parmi les valeurs suivantes : <Slow3> (Lent3), <Slow2> 
(Lent2), <Slow1> (Lent1), <Normal> (Normal), <Fast1> (Rapide1), <Fast2> 
(Rapide2), <Fast3> (Rapide3).

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On
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UTILISATION DU MENU MUSIQUE (Suite)
Régler l’intervalle de saut
Vous pouvez avancer rapidement dans un fi chier à intervalles variés. 
Sautez l’ensemble de la plage ou sautez plusieurs secondes à la fois.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Skip Interval> (Saut 
Intervalle), puis sur le bouton [Sélection].

Le menu <Skip Interval> (Saut Intervalle) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner l’intervalle de saut souhaité, puis sur le bouton
[Sélection].

Choisissez entre <1 Song> (1 chanson), <5sec>, <10sec>, <30sec> et 
<1min>.

Si le fi chier a été encodé avec un débit binaire variable (VBR), il se peut 
que la longueur réelle de l’intervalle de saut soit légèrement différente de 
celle que vous avez sélectionnée.

Music
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UTILISATION DU MENU MUSIQUE (Suite)
Pour défi nir la répétition d’un segment
Cette fonction vous permet d’écouter des parties spécifi ques d’une 
plage de façon répétée. Recommandée pour l’apprentissage d’une 
langue.
1. Appuyez légèrement sur [ ] à l’endroit voulu 

pendant la lecture de la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Repeat A-B Mode On> (Mode 
Répéter A-B activé), puis sur le bouton [Sélection].

L’écran de confi guration des répétitions de segments 
s’affi che.

3. Appuyez légèrement sur l’icône [ ] au début de 
la section que vous souhaitez répéter.

Le point de départ est réglé et le symbole < > apparaît dans la barre de 
progression de la lecture.

4. Appuyez légèrement à nouveau sur [ ] pour défi nir la fi n de la 
section que vous souhaitez répéter.

Le symbole < > apparaît dans la barre de progression de la lecture et la 
lecture répétée de la section spécifi ée démarre.

Annulation de la répétition d’un segment
1. Appuyez légèrement sur [ ] pendant la répétition du segment.

La répétition du segment est annulée.

La répétition du segment s’annule automatiquement dans le cas suivant :
- lorsque le début du segment à répéter est défi ni mais que la fi n ne l’est 

pas avant que la plage en cours ne se termine.
- Si le point de fi n est spécifi é sur une durée de lecture inférieure à 3 

secondes à compter du point de début.
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regarder une vidéo
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.
Transférez les fi chiers vidéo vers le lecteur à l’aide de <EmoDio>.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

REGARDER UNE VIDÉO
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Videos> (Vidéos), puis sur le 
bouton [Sélection].

La liste des <Videos> (vidéos) s'affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour
sélectionner la vidéo à lire, puis sur le bouton [Sélection].

La lecture du fi chier vidéo sélectionné démarre horizontalement.

PAUSE
1. Appuyez légèrement sur le bouton

[Sélection] durant la lecture vidéo.
Le lecteur met la lecture en pause.

2. Appuyez légèrement à nouveau sur le 
bouton [Sélection].

Le lecteur reprend au dernier point de 
lecture.

Avant de procéder au transfert du fi chier vidéo vers le lecteur à l’aide de la fonction 
<EmoDio>, le fi chier est tout d’abord converti automatiquement au format SVI. La 
taille du fi chier est également réglée automatiquement.
Pour obtenir plus d’informations à ce sujet, reportez-vous à <EmoDio>.

REMARQUE

REMARQUE

Bouton [Haut, Bas]

Bouton [Gauche, Droite]
<En affi chage horizontal>
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PASSER A UNE SEQUENCE SPECIFIQUE
1. En affi chage horizontal, appuyez longuement sur le 

bouton [Gauche, Droite].
Cette option vous permet de reculer ou d’avancer dans le 
fi chier vidéo en cours.

2. Relâchez le bouton une fois la position souhaitée 
atteinte.

La lecture de la vidéo démarre à partir de cette position.

LIRE LE FICHIER VIDEO PRECEDENT
Appuyez légèrement sur le bouton [Gauche] dans les 
3 secondes suivant le démarrage de la lecture du fi chier 
en cours.
Appuyez deux fois sur le bouton [Gauche] 3 secondes 
après le démarrage de la lecture du fi chier en cours.

Cette opération permet de revenir à la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
Appuyez légèrement sur le bouton [Droite].

Cette opération permet d’accéder au fi lm suivant.

Video Track 1

Video Track 1

Video Track 2
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UTILISATION DU MENU VIDEO
Réglage d'un signet
La défi nition d'un signet vous permet de retrouver facilement la position 
correspondante ultérieurement.
1. Appuyez sur [ ] pour affi cher la scène 

souhaitée durant la lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Add Bookmark> (Ajouter 
signet), puis sur le bouton [Sélection].

Le point de lecture/d'arrêt courant est ajouté au signet. 
Le symbole [  ] apparaît dans la barre de progression de la lecture. 

La fenêtre Réécrire apparaît si un signet a déjà été défi ni. Si vous sélectionnez 
<Yes> (Oui), le signet préalablement défi ni est supprimé et un nouveau signet est 
ajouté.
Un signet peut être défi ni pour chaque fi chier vidéo (50 signets au maximum).

Accéder à lire/Supprimer un signet
1. Appuyez légèrement sur [ ] pendant la lecture 

de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Go to Bookmark> (Accéd. 
à Signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur le bouton [Sélection].

Lorsque vous avez sélectionné <Go to Bookmark> (Accéd. à Signet), le lecteur 
accède au signet sélectionné et commence la lecture.
L’option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier vidéo.

Pour quitter le menu, appuyez légèrement sur [ ].

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDEO (Suite)
Régler la luminosité
Vous pouvez régler la luminosité de l’écran.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Brightness>
(Luminosité), puis sur le bouton [Sélection].

Le menu <Brightness> (Luminosité) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour spécifi er le 

degré de luminosité souhaité, puis sur le bouton [Sélection].
Choisissez entre <0~10>.

Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre de vidéo.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <DNSe>, puis sur le 
bouton [Sélection].

Le menu <DNSe> s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le 

DNSe de votre choix, puis sur le bouton [Sélection].
Choisissez entre <Normal>, <Drama> (Drame) et <Action>.

Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation du son conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de musique 
que vous écoutez.

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
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affi chage des images
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Transférez les fi chiers image vers le lecteur à l’aide de <EmoDio>.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

AFFICHAGE DES IMAGES
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Pictures> (Images), puis sur le 
bouton [Sélection].

La fenêtre de prévisualisation apparaît.
3. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner l’image que vous souhaitez 
visualiser, puis sur le bouton [Sélection].

L’image sélectionnée s'affi che.
Appuyez légèrement su [ ] pour aller à la fenêtre de 
prévisualisation.

Accéder à l’image précédente/suivante
En affi chage horizontal, appuyez légèrement 
sur le bouton [Gauche, Droite].

L’image précédente/suivante s'affi che.
Avant le transfert du fi chier image vers le lecteur à l'aide 
du logiciel <EmoDio>, celui-ci est tout d’abord converti 
automatiquement au format JPG. La taille du fi chier est 
également réglée automatiquement. Pour obtenir plus d’informations à ce sujet, reportez-vous à 
<EmoDio>.

 s’affi che lorsque les fi chiers JPG comportent des données incorrectes au niveau des vignettes.
Certaines images peuvent être affi chées lentement.
Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour rechercher 
une image. Reportez-vous à la page 21.

Bouton [Haut, Bas]

Bouton [Gauche, Droite]
<En affi chage horizontal>

REMARQUE

REMARQUE
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UTILISATION DU MENU IMAGE
Ecouter de la musique ou la radio FM durant 
l’affi chage des images
Vous pouvez goûter au plaisir d’écouter de la musique ou la radio FM 
tout en affi chant vos images.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Picture> (Image) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Music On>
(Musique activée) ou <FM Radio On> (Radio 
FM activée) puis sur le bouton [Sélection].

A chaque fois que vous appuyez légèrement sur les options <Music On> 
(Musique activée) ou <FM Radio On> (Radio FM activée), vous faites basculer 
l’appareil entre activation et désactivation du son.

Visionner un diaporama
Marche à suivre  1
1. Appuyez légèrement sur le bouton [Sélection] en 

visionnant une image.
Le symbole [ ] s’affi che à l’écran et le lecteur démarre 
le diaporama.

Marche à suivre  2
1. En mode de prévisualisation de l’image, appuyez 

légèrement sur [ ].
2. Appuyez légèrement sur le bouton [Haut, Bas]

pour sélectionner <Start Slideshow> (Démarrer 
diaporama), puis sur le bouton [Sélection].

Le symbole [ ] s’affi che à l’écran et le lecteur démarre le diaporama.

Pour quitter le menu, appuyez légèrement sur [ ].

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin

Picture Image 1.jpg
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Start Slideshow
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UTILISATION DU MENU IMAGE (Suite)
Arrêt du diaporama

Marche à suivre  1
1. En mode diaporama, appuyez légèrement

sur le bouton [Sélection].
Le diaporama s’arrête.

Marche à suivre  2
1. En mode diaporama, appuyez légèrement sur 

[ ].
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
<Stop Slideshow> (Arrêt diaporama), puis sur le bouton [Sélection].

Le diaporama s’arrête.

Régler la vitesse du diaporama
1. En mode diaporama, appuyez légèrement 

sur [ ].
Le menu du diaporama apparaît.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Slideshow Speed>
(Vitesse diaporama), puis sur le bouton
[Sélection].

Le menu <Slideshow Speed> (Vitesse diaporama) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la 
vitesse souhaitée, puis sur le bouton [Sélection].

Choisissez entre <Fast> (Rapide), <Normal> et <Slow> (Lent).

Stop Sildeshow
Slideshow Speed
Transition Effect

Stop Sildeshow
Slideshow Speed
Transition Effect
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UTILISATION DU MENU IMAGE (Suite)
Agrandir une image
Vous pouvez zoomer sur une image.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Zoom> (Zoom), 
puis sur le bouton [Sélection].

Le menu <Zoom> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le 
niveau de zoom souhaité puis sur le bouton [Sélection].

Choisissez entre <100%>, <200%> et <400%>.

4. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite]
pour accéder à la partie de l’image que vous souhaitez agrandir.

Annuler le zoom

Appuyez légèrement sur le bouton [Sélection] en visionnant une 
image agrandie.

Cette fonction permet de revenir à la taille initiale.

L’agrandissement d’un fi chier image volumineux peut prendre un certain 
temps.

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin
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UTILISATION DU MENU IMAGE (Suite)
Pour faire pivoter une image
Vous pouvez faire pivoter l’image selon vos envies.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Rotate> (Pivoter), 
puis sur le bouton [Sélection].

Le menu <Rotate> (Pivoter) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
l’angle souhaité, puis sur le bouton [Sélection].

Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.

Régler la fonction Auto Pivot (Pivot automatique)
La fonction Pivot automatique fait tourner l’image proportionnellement 
de sorte qu’elle s’affi che à l’écran selon la taille maximale possible.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Auto Pivot> (Pivot 
automatique), puis sur le bouton [Sélection].

Le menu <Auto Pivot> (Pivot automatique) 
s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
<On> (Marche), puis sur le bouton [Sélection].

La fonction Pivot automatique est ainsi défi nie.

Music On
FM Radio On
Start Sildeshow
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UTILISATION DU MENU IMAGE (Suite)
Modifi er l’effet de transition
Vous pouvez régler l’effet de transition de sorte à spécifi er le 
basculement de l’image actuelle sur l’image précédente ou suivante. 
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Transition Effect>
(Effet de transition), puis sur le bouton
[Sélection].

Le menu <Transition Effect> (Effet de transition) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 

l’effet de transition souhaité, puis sur le bouton [Sélection].
Faites votre sélection parmi les options suivantes : <Off> (Désactivé), <Auto> 
(Auto), <Cover> (Couvercle), <Fade> (Fondu), <Push> (Appuyer), <Split> 
(Partagé), <Blinds> (Caches) et <Zoom> (Zoom).

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.
1. Sélectionnez le fi chier image à défi nir comme 

image de fond d'écran et appuyez légèrement 
sur [ ].

Le menu <Pictures> (Images) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, 

Bas] pour sélectionner <Select as My Skin>
(Sélectionner comme habillage), puis sur le 
bouton [Sélection].

La fenêtre de confi rmation d’enregistrement apparaît.
3. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <Yes> (Oui), puis sur le bouton [Sélection].
L'image sélectionnée est défi nie comme fond d'écran.
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lecture de texte
Qu’il s’agisse d’un roman, d’un scénario ou d’un article, votre lecteur 
MP3 vous permet de le lire tout en écoutant de la musique !

Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Transférez les fi chiers texte vers le lecteur à l’aide de <EmoDio>.
Réglez la langue de votre choix pour le texte. Reportez-vous à la page 69.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

LECTURE DE TEXTE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Texts> (Textes), puis sur le 
bouton [Sélection].

La liste des fi chiers texte s'affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner le fi chier texte souhaité, puis sur le bouton
[Sélection].

Le texte s'affi che à l'écran.
Appuyez longuement sur le bouton [Sélection] pour affi cher le format plein l’écran 
Pour revenir sur l’écran précédent, appuyez longuement à nouveau sur le bouton 
[Sélection].

Accéder à la page précédente/suivante
Appuyez légèrement sur le bouton [Gauche, Droite].

Appuyez longuement sur le bouton [Gauche, Droite] pour accéder de manière 
continue à la page précédente/suivante.

Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour 
rechercher un fi chier texte. Reportez-vous à la page 21.
Votre lecteur MP3 prend en charge les fi chiers au format TXT en mode Texte.

REMARQUE

REMARQUE
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UTILISATION DU MENU TEXTE
Ecouter de la musique ou la radio FM durant la 
lecture de texte
Vous pouvez goûter au plaisir d’écouter de la musique ou la radio FM 
tout en lisant vos textes.
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Music On> (Musique activée) 
ou <FM Radio On> (Radio FM activée) puis sur le 
bouton [Sélection].

A chaque fois que vous appuyez légèrement sur les 
options  <Music On> (Musique activée) ou <FM Radio 
On> (Radio FM activée), vous faites basculer l’appareil entre activation et 
désactivation du son.

Accéder à la première page
Utilisez cette fonction pour affi cher le texte de la première page.
1. Appuyez légèrement sur [ ] pendant l’affi chage du texte.

Le menu <Text> (Texte) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner <Go to 1st page> (Aller à la 1ère 
page), puis sur le bouton [Sélection].

Une fenêtre de confi rmation s’affi che.
3. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Yes> (Oui), puis sur le 
bouton [Sélection].

Permet d’accéder à la première page.

Pour quitter le menu, appuyez légèrement sur [ ].
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UTILISATION DU MENU TEXTE (Suite)
Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.
1. Appuyez légèrement sur [ ] à la page voulue 

pendant la consultation d'un texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Add Bookmark> (Ajouter 
signet), puis sur le bouton [Sélection].

L'écran du texte actuel est associé à un signet et le 
symbole [ ] s'affi che dans le coin supérieur gauche. 

La fenêtre Réécrire apparaît si un signet a déjà été 
défi ni. Si vous sélectionnez <Yes> (Oui), le signet préalablement défi ni est 
supprimé et un nouveau signet est ajouté.
Un signet peut être défi ni pour chaque fi chier texte (50 signets au maximum).

Accès à/Suppression d’un signet
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Go to Bookmark> (Accéd. 
à Signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur le bouton [Sélection].

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez <Delete Bookmark> 
(Supprimer signet).
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UTILISATION DU MENU TEXTE (Suite)
Réglage de la couleur de la visionneuse de texte
Choisissez la couleur d’affi chage du texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Text Viewer Color> (Coul. 
visionn. text), puis sur le bouton [Sélection].

La fenêtre du menu <Text Viewer Color> (Coul. visionn. 
text) apparaît.

3. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner la couleur de la visionneuse de texte 
souhaitée, puis sur le bouton [Sélection].

Sélectionnez l'une des options comprises entre <Type 1> et <Type 6>.

Modifi er la taille de la police
Vous pouvez modifi er la taille de la police utilisée dans le texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Font Size> (Taille police), puis 
sur le bouton [Sélection].

Le menu <Font Size> (Taille police) s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner la taille de police 
souhaitée, puis sur le bouton [Sélection].

Choisissez entre <Small> (Petit), <Medium> (Moyen) et <Large>.
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UTILISATION DU MENU TEXTE (Suite)
Régler le mode d’affi chage du texte
Vous pouvez affi cher le texte horizontalement ou verticalement.
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <View Type> (Type d’affi chage), 
puis sur le bouton [Sélection].

L’écran <View Type> (Type d’affi chage) apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner le type d’affi chage souhaité, puis 
sur le bouton [Sélection].

Choisissez entre <Normal> (Normal) et <Horizontal> (Horizontal).
Sélectionnez <Normal> (Normal) pour affi cher le texte à la verticale et 
<Horizontal> (Horizontal) pour faire pivoter le texte à l’horizontale.
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UTILISATION DU MENU TEXTE (Suite)
Régler la langue du texte
Vous pouvez sélectionner la langue du texte à affi cher.
1. Appuyez légèrement sur [ ] pendant l’affi chage du 

texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Language> (Langue), puis sur 
le bouton [Sélection].

La liste <Language> (Langue) s’affi che.
<English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, 
<Thai>, <Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, 
<Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>, 
<Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish>, <Vietnamese>.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la 
langue de votre choix, puis sur le bouton [Sélection].

Vous pouvez affi cher le texte dans la langue sélectionnée.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
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UTILISATION DU MENU TEXTE (Suite)
Ecouter du TTS (Text to Speech) (Texte en Son)
Servez-vous de la fonction TTS (Texte en Son) de l’application 
<EmoDio> afi n de convertir un fi chier de texte en un fi chier TTS et 
écouter celui-ci.

Avant de démarrer - Transférez les fi chiers TTS vers le lecteur à l’aide de 
<EmoDio>.

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite] 
pour sélectionner <Texts> (Textes), puis sur le bouton [Sélection].

La liste des fi chiers TTS s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner un 
fi chier TTS téléchargé puis sur le bouton [Sélection].

Vous pouvez ainsi écouter le fi chier.

Vous pouvez régler la vitesse de lecture et l’intervalle de saut en appuyant 
légèrement sur [ ].
Pour les détails sur la fonction TTS (Texte en Son) sous <EmoDio>, 
reportez-vous à la <EmoDio>.

REMARQUE
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ecouter la radio FM
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

ECOUTER LA RADIO FM
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Tap the [Up, Down, Left, Right] button to select <FM

Radio> and tap the [Select] button.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <FM Radio> (Radio FM), puis 
sur le bouton [Sélection].

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (SILENCE)
1. Appuyez légèrement sur le bouton [Sélection] tout en écoutant la radio FM.

Le son est désactivé.
2. Appuyez légèrement à nouveau sur le bouton [Sélection] pour reprendre 

l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez des 
fréquences. 
Les écouteurs sont utilisés comme antennes de réception des ondes FM.
Dans les zones où la qualité de réception est mauvaise, il se peut que le lecteur ne 
détecte aucune fréquence FM.

REMARQUE

REMARQUE
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POUR RECHERCHER DES STATIONS DE RADIO FM
1. Appuyez longuement sur le bouton [Gauche, Droite] et 

relâchez en mode Manuel.
La recherche s’arrête sur la fréquence la plus proche du point de 
relâchement du bouton.

OU,

1. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
rechercher les fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression du bouton.

Auto Searching

News
Today Headline
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UTILISATION DU MENU DE LA RADIO FM
Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche 
manuelle d’une fréquence à la fois sur la bande FM.
1. Appuyez légèrement sur [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Go to Preset Mode> (Aller au 
mode pré-progr), puis sur le bouton [Sélection].

<Preset> s’affi che.

Si aucune fréquence de présélection n’est défi nie, le 
lecteur ne passe pas en mode Présélection.

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.
1. Appuyez légèrement sur [ ] en mode Présélection.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Go to Manual Mode> (Aller au 
mode manuel), puis sur le bouton [Sélection].

L’option <Manual> (Manuel) s’affi che à l’écran.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection
Vous pouvez enregistrer jusqu’à 30 stations dans la mémoire de votre 
lecteur MP3 et y accéder en appuyant simplement sur un chiffre. 
Le lecteur MP3 peut soit choisir uniquement les stations souhaitées 
(manuellement) ou rechercher et enregistrer automatiquement les 
stations locales.
Manuel : sélectionnez uniquement les stations que vous souhaitez 
enregistrer
1. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner une fréquence à 
prérégler en mode manuel, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Add to Preset> (Ajouter aux 
présél.), puis sur le bouton [Sélection].

La fréquence sélectionnée est ajoutée à la liste de 
présélections.

3. Pour défi nir un numéro préréglé pour les autres fréquences, 
suivez les étapes 1 à 2 ci-dessus.

Si la même fréquence est déjà défi nie, le réglage est désactivé.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection (Suite)
Automatique : enregistrez automatiquement toutes les stations 
captées par le lecteur
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Auto Preset> (Présélection 
auto), puis sur le bouton [Sélection].

Une fenêtre de confi rmation s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner <Yes> (Oui), puis sur le 
bouton [Sélection].

Jusqu’à 30 fréquences radio sont réglées automatiquement.

Pour annuler la présélection automatique
Pour annuler la présélection automatique, appuyez légèrement sur le 
bouton [Sélection].

La présélection automatique est annulée et seules les fréquences réglées 
jusque-là sont enregistrées.

Si vous vous rendez dans une autre région avec votre lecteur MP3, 
vous souhaiterez peut-être régler à nouveau les stations enregistrées. 
Pour supprimer les stations préréglées et en enregistrer de nouvelles, 
il suffi t de répéter le processus.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

News
Today Headline

UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée
En mode Présélection, appuyez légèrement sur le 
bouton [Gauche, Droite] pour faire défi ler les stations 
présélectionnées.

Vous pouvez écouter la fréquence radio enregistrée.

Pour supprimer une présélection 
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. En mode Présélection, appuyez légèrement sur 

le bouton [Gauche, Droite] pour rechercher une 
fréquence présélectionnée à supprimer, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <Delete from Preset> (Suppr. 
du prérégl.), puis sur le bouton [Sélection].

La fréquence sélectionnée est supprimée.

3. Pour supprimer les autres fréquences présélectionnées, suivez les 
étapes 1 à 2 ci-dessus.
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FM Record

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

UTILISATION DU MENU DE LA RADIO FM (Suite)
Enregistrer un programme FM
Vous pouvez à tout moment enregistrer un programme FM tout en écoutant la radio.
1. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner une fréquence à 
enregistrer en mode Radio FM, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, Bas]

pour sélectionner <Start Recording> (Démarrer 
l’enregistrement), puis sur le bouton [Sélection].

Le nom du fi chier créé automatiquement s'affi che et 
l'enregistrement démarre.

Pour arrêter un enregistrement
1. Appuyez légèrement sur le bouton [Sélection]

pendant l’enregistrement.
Un message apparaît vous demandant si vous souhaitez 
écouter le fi chier que vous venez d’enregistrer.

2. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner <Yes> (Oui) ou <No>
(Non) puis sur le bouton [Sélection].

Sélectionner <Yes> (Oui) vous permet de lire le fi chier que 
vous venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le fi chier enregistré.

Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés)
La durée maximale d’un fi chier d’enregistrement radio FM est de 5 heures.
Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement radio FM.
Vous pouvez effectuer jusqu’à 15 heures environ d’enregistrement (sur la base 
de 128 Kbit/s, 1 Go).
Le nom du fi chier enregistré est spécifi é automatiquement sous la forme : « 
FM_AAMMJJ_XXX.MP3 ». « FM » signifi e qu’il s’agit d’un enregistrement de 
la radio FM, « AAMMJJ » correspond à la date d’enregistrement et « XXX » 
correspond au numéro du fi chier enregistré.

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour régler la Sensibilité FM
Pour recevoir plus ou moins de fréquences radio FM, paramétrez la 
fonction FM Sensitivity (Sensibilité FM).
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <FM Sensitivity> (Sensibilité 
FM), puis sur le bouton [Sélection].

Le menu <FM Sensitivity> (Sensibilité FM) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner le niveau de recherche souhaité, 
puis sur le bouton [Sélection].

Choisissez entre <High> (Haut), <Middle> (Milieu) et <Low> (Bas).
Le réglage <High> (Haut) vous permet de recevoir le plus grand nombre de 
fréquences.

Pour quitter le menu, appuyez légèrement sur [ ].

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en prévision d’un 
voyage à l’étranger.
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner <FM Region> (Région Radio), 
puis sur le bouton [Sélection].

Le menu <FM Region> (Région Radio) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas]
pour sélectionner la zone régionale de la radio FM, 
puis sur le bouton [Sélection].

Choisissez entre <Korea/US> (Corée/USA), <Japan> (Japon) ou <Other 
Countries> (Autres pays).

Les fréquences radio que vous avez enregistrées précédemment seront 
supprimées si vous modifi ez le réglage <FM Region> (Région FM) de votre 
lecteur.
La région FM peut être supprimée ou modifi ée en fonction de la région cible 
du lecteur.
Bande de fréquences par région
- Korea/US (Corée/USA) : Recherchez des fréquences FM comprises entre 
  87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0 
  MHz et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres pays) : Recherchez des fréquences FM comprises 

entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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Datacasts 1/4

Datacast 1
Datacast 2
Datacast 3
Datacast 4

affi chage des diffusions de donnees
AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à <Datacasts> (Dif. donn.).

Avant de démarrer – Transfert de l’élément de chaîne souhaité vers le lecteur avec 
<EmoDio>.
Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement les informations mises à jour sans avoir à vous 
rendre sur les sites d’actualités, les blogs ou les UCC.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 
Droite] pour sélectionner <Datacasts> (Dif. donn.), puis sur le 
bouton [Sélection].

La liste de diffusion s'affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner la liste de canaux souhaitée, puis sur le bouton
[Sélection].

La liste des fi chiers s'affi che.

Icône  : Texte principal de 
l’élément transféré

Icône  :Fichier image

Icône  :Fichier musical

Icône  : Fichier vidéo

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le fi chier souhaité, puis sur le bouton [Sélection].

La lecture du fi chier sélectionné démarre.

Reportez-vous à <Datacasts> (Dif. donn.) dans <EmoDi> (EmoDi) pour obtenir des 
instructions détaillées.

REMARQUE

REMARQUE
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utilisation du pack plus
Le pack plus vous permet d’utiliser différentes fonctions telles que les 
jeux ou l’enregistrement vocal.

Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

ENREGISTREMENT VOCAL
Vous permet d’effectuer un enregistrement vocal.

Créer un enregistrement vocal
1. Appuyez longuement sur [ ] pour accéder à l’écran 

du menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, 

Gauche, Droite] pour sélectionner <Prime Pack>
(Pack plus), puis sur le bouton [Sélection].

La liste <Prime Pack> (Pack plus) s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, Droite]
pour sélectionner <Voice REC> (ENR vocal), puis 
sur le bouton [Sélection].

4. Appuyez légèrement sur le bouton [Sélection].
Le lecteur démarre l’enregistrement.

Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés).
La durée maximale d’un fi chier d’enregistrement vocal est de 5 heures.
Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement vocal.
Vous pouvez effectuer jusqu’à 15 heures environ d’enregistrement (sur la 
base de 128 Kbit/s, 1 Go).
Le nom du fi chier enregistré est spécifi é automatiquement sous la 
forme « VCE_AAMMJJ_XXX.MP3 ». « VCE » signifi e qu’il s’agit d’un 
enregistrement vocal, « AAMMJJ » correspond à la date d’enregistrement 
et « XXX » correspond au numéro du fi chier enregistré.

REMARQUE
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Enregistrement VOCAL (Suite)

Arrêter l’enregistrement vocal
1. Appuyez légèrement sur le bouton [Sélection] 

pendant l’enregistrement.
Un message apparaît vous demandant si vous 
souhaitez écouter le fi chier que vous venez 
d’enregistrer.

2. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner <Yes> (Oui) ou <No>
(Non) puis sur le bouton [Sélection].

Sélectionner <Yes> (Oui) vous permet de lire le fi chier 
que vous venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le fi chier enregistré.

Ne tenez pas le microphone trop rapproché ou trop éloigné de votre 
bouche car cela pourrait affecter la qualité de l’enregistrement.
L’enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.

Voice Record

ATTENTION
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LECTURE DE JEUX FLASH
Votre lecteur mp3 est livré avec des jeux passionnants qui sont préchargés sur l’appareil !

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 
Droite] pour sélectionner <Prime Pack> (Pack plus), puis 
sur le bouton [Sélection].

La liste <Prime Pack> (Pack plus) s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, Droite]
pour sélectionner <Games> (Jeux), puis sur le bouton
[Sélection].

La liste <Games> (Jeux) s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le jeu 
souhaité, puis sur le bouton [Sélection].

BOMB BOMB
Ce jeu de réfl exion consiste à déplacer trois blocs afi n de faire 
correspondre la couleur des blocs en forme de marteau avec celle des 
blocs empilés, action qui permet de faire disparaître les blocs. Enlevez 
autant de blocs que possible.

Appuyez légèrement sur le bouton [Gauche, Droite]
pour faire bouger les blocs vers la gauche ou la 
droite.
Appuyez légèrement sur le bouton [Haut] pour 
déplacer les blocs sur le plan horizontal ou vertical.
Appuyez légèrement sur le bouton [Bas] pour
déposer les blocs.

REMARQUE
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LECTURE DE JEUX VIDEO (Suite)
Bubble Smile
Vous devez marquer le plus de points possibles en déplaçant trois 
bulles afi n de les aligner à l’horizontale ou en diagonale.

Appuyez légèrement sur le bouton [Haut, Bas, 
Gauche, Droite] pour déplacer la combinaison de 
trois bulles.
Appuyez légèrement sur [ ] pour modifi er l’ordre 
des bulles dans le sens des aiguilles d’une montre.
Appuyez légèrement sur [ ] pour changer l’ordre 
des bulles dans le sens contraire des aiguilles d’une 
montre.
Vous ne marquerez des points que si au moins trois 
bulles sont alignées.

Chicken Runaway

Ce jeu consiste à déplacer une poule et des poulets de droite à gauche 
et inversement, dans le but d’éviter les balles qui tombent du ciel afi n 
que la poule reste en sécurité le plus longtemps 
possible.

Appuyez légèrement sur le bouton [Gauche, Droite]
pour faire bouger la poule vers la gauche ou la droite.

Des jeux peuvent être ajoutés ou modifi és sans avis préalable.
Pour plus d'informations sur les règles du jeu, consultez la 
section Aide.

REMARQUE
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AFFICHAGE DE LA CARTE INTERNATIONALE DES MÉTROS
Vous pouvez parcourir les plans des métros du monde entier en prenant notes 
des différentes stations.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 

Droite] pour sélectionner <Prime Pack> (Pack plus), puis 
sur le bouton [Sélection].

La liste <Prime Pack> (Pack plus) s’affi che.
3. Appuyez légèrement sur le bouton [Gauche, Droite]

pour sélectionner <Subway> (Métro), puis sur le bouton
[Sélection].

L’écran de sélection des pays du monde s’affi che.
4. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite] pour 

sélectionner la zone souhaitée, puis sur le bouton [Sélection].
Sélectionnez un continent : <AMERICA> (AMÉRIQUE), <EUROPE> (EUROPE), 
<ASIA/OCEANIA> (ASIE/ OCÉANIE).
Les villes de la région sélectionnée s’affi chent.

5. Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner la 
ville souhaitée, puis sur le bouton [Sélection].

Le plan du métro de la ville sélectionnée s’affi che.
6. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite] pour 

sélectionner la zone à agrandir, puis sur le bouton [Sélection].
Si la carte agrandie inclut des informations sur les attractions touristiques adjacentes 
à la station de métro, appuyez légèrement à nouveau sur le bouton [Sélection] pour 
affi cher la fl èche rouge. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 
Droite] pour sélectionner l’icône souhaitée, puis sur le bouton [Sélection]. Vous 
pouvez repérer l’attraction touristique.
Appuyez légèrement sur [ ] pour retourner sur l’écran de sélection des régions du 
monde.
Il se peut le plan diffère du plan réel du métro.

REMARQUE
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dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP3, des 
solutions vous sont proposées dans cette liste. Si le problème persiste, 
contactez le service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allumera pas si la batterie est 
entièrement déchargée. Rechargez la batterie 
et remettez l’appareil sous tension.

• Appuyez sur le bouton de réinitialisation.

Les boutons ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur [ ] est 
orienté vers le haut du lecteur.

• Vérifi ez que vous avez appuyé sur le bouton 
adéquat, puis essayez à nouveau.

• Appuyez sur le bouton de réinitialisation.

L’écran ne s’allume pas.

• Il se peut que les données affi chées à l’écran 
ne soient pas visibles sous les rayons directs du 
soleil.

• Si <Display Off> (Affi ch. Désactivé) est 
sélectionné dans <Settings> (Paramètres) 
<Display> (Affi cher), l’écran s’éteint.
Appuyez sur un bouton et vérifi ez si l’écran 
s’allume.
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PROBLÈME SOLUTION

L’alimentation est 
coupée.

• L’alimentation se coupe automatiquement lorsque 
la batterie est entièrement déchargée. Rechargez 
la batterie.

• Si <Auto Power Off> (Extinction auto) est 
sélectionné dans <Settings> (Paramètres) 
<System> (Système), l’alimentation est coupée 
lorsque le lecteur est en mode Pause. Allumez le 
lecteur.

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction 
du mode son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite 
si vous exposez le lecteur à des températures 
basses ou élevées pendant des périodes 
prolongées.

Dysfonctionnement du 
programme EmoDio

• Vérifi ez que votre ordinateur dispose de la 
confi guration requise.

La connexion à 
l’ordinateur est 
interrompue.

• Assurez-vous que le câble USB est branché 
correctement et essayez à nouveau.

• Exécutez la mise à jour de Windows sur votre 
ordinateur. Sélectionnez les mises à jour 
principales et l’ensemble des modifi cations 
provisoires, puis mettez à jour tous les 
composants. Redémarrez l’ordinateur et 
rebranchez l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si plusieurs programmes sont ouverts sur votre 
ordinateur (dont <EmoDio>), le taux de transfert 
du fi chier sera ralenti. Quittez les programmes 
que vous n’utilisez pas et procédez à nouveau au 
transfert.
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PROBLÈME SOLUTION

Le lecteur ne fonctionne 
pas.

• Vérifi ez que le fi chier disponible a bien été 
enregistré dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas 
endommagé.

• Vérifi ez que la puissance de la batterie est 
suffi sante.

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement 
branché. Rebranchez-le au besoin.

• Assurez-vous qu’il reste de l’espace disponible 
sur la mémoire.

• Appuyez sur le bouton de réinitialisation.

Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché 
durant le transfert du fi chier ou des données. 
Si tel est le cas, les fi chiers/données 
mais également l’appareil risquent d’être 
endommagés. 
Vous devez faire preuve d’une extrême 
prudence à cet égard car Samsung ne saurait 
en aucun cas être tenu responsable de la perte 
des données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR (débit 
binaire variable).

L’appareil est chaud.
• Les phases de chargement peuvent générer 

de la chaleur. Cela n’a aucune incidence 
sur la durée de vie de l’appareil ou sur son 
fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo

• Essayez à nouveau de télécharger le clip vidéo 
en passant par le logiciel EmoDio.
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annexe
ARBORESCENCE DES MENUS
Voici une rapide présentation de la façon dont les menus et les fonctions sont 
organisés dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Musique Vidéos Images Textes Radio FM Dif. donn. Pack plus Dossier
Navigateur Paramètres

ENR vocal Style du 
menu

Jeux Son

Métro Affi cher

Language

Date et 
heure

Système

Effets 
Sonores

Ajouter
signet

Musique
activée

Musique
activée

Aller au mode 
pré-progr / 

Aller au mode 
manuel

DNSe Accéd. à 
Signet

Radio FM 
activée

Radio FM 
activée

Ajouter aux 
présél. / Suppr. 

du prérégl.
Mode
lecture

Supprimer
signet

Start
Slideshow

Aller à la 
1ère page

Présélection
auto

Ecran Lect 
mus. Luminosité Zoom Ajouter

signet
Démarrer

l’enregistrement

Vitesse de 
lecture DNSe Pivoter Accéd. à 

Signet Sensibilité FM

Saut
Intervalle

Pivot 
automatique

Supprimer
signet Région Radio

Mode
Répéter A-

B activé
Effet de 

transition
Coul.

visionn.
text

Sél.
comme

habillage
Taille police

Type 
d’affi chage

Langue
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-Q1
Puissance nominale 5,0 V CC / 500 mA
Alimentation de la batterie 
intégrée 620 mAh/3,7 V CC

Compatibilité

AUDIO : MPEG1/2/2.5 Couche 3 (8 kbps à 320 kbps, 
22 kHz  à 48 kHz), WMA (8 kbps à 320 kbps, 
8 kHz à 48 kHz)

VIDEO : SVI (Vidéo : MPEG4, Audio : MP3 (44,1 kHz, 
128 Kbps), 
WMV (Vidéo : WMV9 Profi l simple, Audio : 
WMA Spec (Max 860 kbps), Résolution : 480 
x 272, Vitesse d’enregistrement : 30 fps)

IMAGE : JPEG (ISO/IEC 10918-1/Annexe F – Mode 
de fonctionnement séquentiel DCT)

Nombre de dossiers/
fi chiers pris en charge

Dossiers : 1 000 maxi ; Fichiers : 6 000 maxi. 
(dossier compris)

Sortie des écouteurs 20 mW/Ch. (France 5 mW/Ch.) (basé sur 16 )
Bande de fréquences de la 
sortie 40Hz~20kHz

Rapport signal-bruit 90 dB

Durée de lecture
Musique : 30 heures maxi. (MP3 128 kbps, 

Volume : 15, Mode Normal, LCD Off)
Vidéo :  4 heures maxi. (Luminosité 5, Volume : 15, 

Mode Normal)
Plage de températures de 
fonctionnement -5 ~ 35°C (23~95°F)

Etui Plastique
Poids 65 g
Dimensions (L x H x P) 51 X 98 X 10,9 mm
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Radio
FM

Fréquence FM 87,5~108,0 MHz T.H.D. FM 1%

Rapport signal FM 55 dB Sensibilité FM utile 38 dB

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.
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LICENCE
L’appareil qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée 
à une utilisation privée non commerciale par l’utilisateur fi nal pour les contenus sous 
licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit 
n’est cédé sous cette licence pour des caractéristiques ou des fonctions du produit 
qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

COMMENT ÉLIMINER CE PRODUIT (DÉCHETS 
D’ÉQUIPEMENTS ÉLECTRIQUES ET ÉLECTRONIQUES)
(Applicable dans les pays de l’Union Européen et aux autres pays européens 
disposant de systémes de collecte sélective) 
Ce symbole sur le produit ou sa documentation indique qu’il 
ne doit pas être éliminé en fi n de vie avec les autres déchets 
ménagers. L’élimination incontrôlée des déchets pouvant 
porter préjudice à l’environnement ou à la santé humaine, 
veuillez le séparer des autres types de déchets et le recycler 
de façon responsable. Vous favoriserez ainsi la réutilisation 
durable des ressources matérielles.
Les particuliers sont invités à contacter le distributeur 
leur ayant vendu le produit ou à se renseigner auprès 
de leur mairie pour savoir où et comment ils peuvent se 
débarrasser de ce produit afi n qu’il soit recyclé en respectant 
l’environnement.
Les entreprises sont invitées à contacter leurs fournisseurs et 
à consulter les conditions de leur contrat de vente. 
Ce produit ne doit pas être éliminé avec les autres déchets commerciaux.
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ELIMINATION DES BATTERIES DE CE PRODUIT
(Applicable aux pays de l’Union européenne et aux autres pays européens 
dans lesquels des systèmes de collecte sélective sont mis en place.)
Le symbole sur la batterie, le manuel ou l’emballage 
indique que les batteries de ce produit ne doivent pas être 
éliminées en fi n de vie avec les autres déchets ménagers. 
L’indication éventuelle des symboles chimiques Hg, Cd 
ou Pb signifi e que la batterie contient des quantités de 
mercure, de cadmium ou de plomb supérieures aux 
niveaux de référence stipulés dans la directive CE 2006/66. 
Si les batteries ne sont pas correctement éliminées, ces 
substances peuvent porter préjudice à la santé humaine ou 
à l’environnement. 
Afi n de protéger les ressources naturelles et d’encourager la réutilisation du 
matériel, veillez à séparer les batteries des autres types de déchets et à les 
recycler via votre système local de collecte gratuite des batteries.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.

Samsung Service Consommateurs
3260 SAMSUNG (€ 0,15/Min) ou 08 25 08 65 65 (€ 0,15/Min)

www.samsung.com/fr


